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What is Canoma?
Canoma lets you quickly create photorealistic 
3D models from scanned or digital 
photographs, without extensive 3D modeling 
skills. No need for specialized equipment or 
calibrations. Canoma even works on historical 
photographs. Canoma models can be posted on 
Web sites or in electronic catalogs, or imported 
into traditional 3D modeling and animation 
software. Canoma is a perfect companion to 
other Web authoring tools. 

Easier to learn than traditional 3D programs 
(with all their modes, tools, and windows), 
Canoma lets 2D graphic illustrators and 
designers create and manipulate realistic 3D 
models—applying all their retouching and 
filtering skills to 3D objects. 

Here’s how Canoma works:

• Take one or more photos of what you want 
to model in 3D. More photos mean greater 
detail. 

• Select 3D shapes (called objects or 
pimitives,) then pin them to the corners of 
objects in your photograph. (There are 
ways to also control edges and alignment.) 

• Preview your 3D creation—move in for a 
close-up look or away, rotate around the 
model, or just walk through it! Canoma 
adds texture to your model right from your 
photographs.

• You can edit areas of texture, letting 
Canoma open your favorite 2D program, 
present you with a head on 2D view of the 
area to edit, then watch as Canoma 
reapplies the edited texture in proper 
perspective! 

• Create animations or export your 3D 
model to other 3D programs or for use on 
the Web. 

The Canoma workspace. 
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What Can You Do with 
Canoma? 
With Canoma you can create very realistic 
three-dimensional (3D) computer models from 
one or more photographs, a process called 
image-assisted modeling. Canoma models have 
simple geometries and use photographs as 
texture source, allowing the pixels to do the 
work of making your models look good. 

Select the face of a Canoma model, bring up a 
2D pixel editing tool, such as Painter or 
Photoshop, and retouch the surface texture, 
add text, or apply a 2D filter. Watch Canoma 
reapply the altered pixels, while retaining 3D 
perspective. 

3D models can be rotated and viewed from 
different directions, allowing customers to 
thoroughly inspect product or merchandise 
models. Once 3D models are completed, you 
can create a simple animation or “walk 
through”, even publish those on the internet. 

Canoma lends itself well to regular, man-made 
objects. Amorphous or very complex shapes 
that may occur in nature such as trees, 
mountains, or curved objects can also be 
approximated, using simple stand-in geometry. 
Canoma also supports translation sweeps or 
extrusion, which allows a polyline contour to be 
swept along a straight axis. 

On-line Catalogs 

You can publish a Web catalog full of Canoma 
models. For example, you could use Canoma to 
create a catalog of “hard goods”, such as 
furniture or appliances, then output it in the 
Metastream format.    

Examples of models created for catalogs. 
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The Metastream format is widely distributed by 
Microsoft and Intel and can be downloaded for 
free from www.metastream.com. Metastream 
uses small, compact files and outputs a single 
file that is easy to maintain and post. 

Streaming a 3D image allows customers to 
experience instant gratification, as they 
manipulate a 3D object. High quality, 
interactive vending, all from within a standard 
Web browser. 

Canoma creates quick, low-polygon count, 
photorealistic models. This can be a fast, cost-
effective way of disseminating information, 
without the security risk that distributing 
detailed blueprints from a CAD program could 
introduce. 

Web Sites, Travel and Tourism, 
Commercial Real Estate 

A 3D preview of property can be a strong sales 
incentive for online travel, real estate sales, or 
vacation rentals. Entertainment, restaurant, 
and hotel information sites all benefit from the 
photorealistic 3D models.  

Interior/Exterior Design and 
Remodeling

If the project is to remodel a kitchen, bathroom 
or the outside of a house, a photograph session 
and a quick modeling session—without 
becoming a wizard—creates a model of how the 
project looks right now. Repeat site visits are 
replaced by a photorealistic 3D model, that’s 
always available for a design meeting. 

• Using the texture editing feature, you and 
your 2D pixel editing tool, such as Painter 
or Photoshop, can make changes to 
surfaces or simulate different lighting. 

• With Canoma’s animation feature, you can 
“walk” perspective clients through the 
suggested changes.  

A Canoma model created from a photo of San Francisco. 
The "For Rent" sign was added using a 2D pixel editing 
program. Walking through a kitchen model. 
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• With a 3D program you can go further, 
changing tiles, sliding in a new dishwasher, 
or actually trying out planned spotlights to 
illuminate that kitchen counter.    

Graphic Design and Advertising 

Industrial design and graphic artists can take 
existing products and packaging, extract the 
graphics, and edit the designs. They can create 
animations or place a package in a different 
environment. 

It’s easy to add billboards, place advertising on 
buses, and change details—all in photorealistic 
perspective, using only Canoma and your 
favorite 2D image editing program. You can 
output the results as 3D models, rendered 2D 
images, or even animations.       

Architecture, Urban Planning, 
Property Development 

Architects can produce rough models of areas 
where new buildings are planned, then 
integrate the photorealistic model produced in 
Canoma with the detailed engineering model of 

Spotlights added to a Canoma model in a 3D program. 

After

Before

You can edit Canoma models with an image-editor. 
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the planned building, giving everyone a good 
preview of how a building might fit into the 
neighborhood. 

Computer Game Developers and 
3D Artists 

With Canoma, you can quickly model a house 
or office, change some textures, add in a few 
monsters, and really try out ideas. 3D artists can 
use Canoma to create quick photorealistic clip 
objects that can be used to enhance existing 3D 
models and animations. 

Canoma models of complete houses or 
interiors can serve as starting points for more 
detailed 3D modeling, since they provide scene 
measurements and object dimensions. 

When You Have 
Questions 
You can find answers to most of your questions 
in the following ways: 

• Canoma User Guide - Providing all the 
information you need to get the most out 
of Canoma. The User Guide is also 
provided as a PDF file on the Canoma CD. 

• Online Help - Providing direct access to 
specific chapters in the User Guide. Online 
Help contains the same information as the 
User Guide. Adobe Acrobat Reader 
software is required to read online Help or 
the PDF version of the User Guide. Adobe 
Acrobat Reader software is on the Canoma 
CD or downloadable for free from 
www.adobe.com. 

• Status line tips - Check the bottom of your 
screen for UI related information. 

• Active Guide - Text can pace you through 
the creation and application of your first 
few primitives. The Active Guide goes away 
after you’ve gained some experience or you 
can turn it off in the program preferences. 

About your User Guide
The Canoma User Guide is for both Macintosh 
and Windows. By convention, Macintosh 
commands precede Windows commands in the 
text. For example, Command/Ctrl+I, is 
equivalent to the Macintosh Command-I and 
the Windows Ctrl+I. For simplicity, the term 
“folder” refers to directories as well as folders. 
The Canoma interface for Macintosh and 
Windows platforms is identical, unless 
otherwise specified.

A Canoma model generated from a photo of the New York 
skyline can let you see how a new building might look in 
the cityscape. 
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When a modifier key differs between the 
Macintosh and Windows platform, the 
Macintosh modifier is listed first followed by a 
slash and the Windows modifier key. Option/
Alt means Macintosh users press the Option 
key and Windows users press Alt. 

There are several conventions used to identify 
paths to certain tools and controls. The 
convention to a menu follows the rule of the 
menu name > menu item. The convention to a 
palette follows the rule of the palette name: 
subpalette name. The convention to a palette 
menu follows the rule of palette name: palette 
menu> menu item. 

Technical Support
MetaSupport is a portfolio of free and fee-
based support options designed to provide 
quality support to you. 

The options are as follows:

FREE On-line Support

On-line support is available on our Web site at 
www.metacreations.com 24 hours a day, 7 days a 
week. Access a list of Frequently Asked 
Questions (FAQs) for each product and find 
solutions immediately. If, after searching our 
on-line options, you still need assistance, you 
can contact MetaCreations Technical Support 
through one of the Telephone Support Services 
listed here. 

Telephone Support

• Standard Support 

Talk person to person with technical 
support representatives and get answers to 
installation, configuration and general 
usage questions. Each product has its own 

support duration. The length of the 
complimentary support period depends on 
whether your MetaCreations product is a 
Level I (receive 90 days of complimentary 
support for a first-time purchase, or 30 
days for an upgrade) or Level II (receive 
complimentary support for one incident 
for a first-time or upgrade purchase) 
product. The support period begins with 
your first call into MetaCreations Technical 
Support, provided you have registered the 
product. 

Toll call: 831-430-4200

• Premium Pay as You Go

When your standard support period ends, 
you can now receive priority access 
personal service regarding installation, 
configuration and general usage questions 
from our qualified support specialists. You 
pay a flat fee that covers all of the necessary 
support for the particular incident. 

Toll-free call: 888-456-6382

• Premium Plus Annual Contract

Annual support contracts are available to 
meet your ongoing support needs. Sign up 
for an annual support agreement to receive 
one year of toll-free priority access person-
to-person assistance. Get answers to 
installation, configuration and general 
usage questions.

• To order toll-free call: 800-846-0111

• For support toll-free call: 
800-683-5872

For a list of currently supported Level I and 
Level II products and the Telephone Support 
options pricing, please visit our web-site at 
www.metacreations.com.
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Technicians are available Monday through 
Friday, 6am to 5pm Pacific Time.

How to Contact Us 

• Free On-line Support: 
www.metacreations.com

• Standard Support: Toll call 831-430-4200

• Premium Pay As You Go: Toll-free call 
888-456-6382

• Premium Plus Annual Contract: 

• To order toll-free call: 800-846-0111

• For support toll-free call: 800-683-5872

International Support

The telephone support services listed here are 
available only in the U.S. and Canada. However, 
if you live outside of the U.S. and Canada, you 
can still access our free on-line support, and 
you can contact a local MetaCreations 
distributor or other third party that may 
provide technical support in your area. Visit our 
World Wide Web site at 

www.metacreations.com 

for information about how to contact a 
MetaCreations distributor in your country.

Installing Canoma
Installation instructions are provided for both 
Windows and Macintosh. Follow the 
instructions appropriate to your system. 

System Requirements 
(Windows)

• Pentium processor 

• Windows 95, Windows 98, Windows NT 

• 32 mb free RAM (48+ mb recommended) 

• 50 mb of hard-disk space 

• 16 bit color (24 bit recommended) 

• CD Rom drive (for install) 

System Requirements
(Macintosh)

• Power PC 

• System 8.0 or higher 

• 32 mb free RAM (48+ mb recommended) 

• 50 mb hard-disk space 

• 16 bit color (24 bit recommended) 

• CD Rom drive (for install) 

Web Installation

To install Canoma from the Web:

1 Go to the MetaCreations Web site. 

2 Follow the instructions on the Web site to 
download the appropriate self-installing 
executable file (Windows or Macintosh).

3 Double-click the file to run it.

4 Follow the instructions provided by the 
installer. The installation dialog displays an 
important ReadMe. 

5 Click Yes/Accept after reading the 
complete ReadMe. 

Note
Canoma is intended for local 
installation only. Do not attempt 
to install it onto a network server. 
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Windows CD Installation

To install Canoma from a CD:

1 Launch Windows. 

2 Insert the Canoma CD-ROM into your 
computer’s CD-ROM drive. The Install 
Canoma dialog appears. 

3 Double-click the Canoma icon. 

4 Follow the instructions provided by the 
installer. The installation dialog displays an 
important ReadMe. 

5 Click Yes after reading the complete 
ReadMe. 

Macintosh CD Installation

To install Canoma on a Macintosh:

1 Insert the Canoma CD-ROM into your 
computer’s CD-ROM drive. The Install 
Canoma dialog appears. 

2 Double-click the Canoma icon. 

3 Follow the instructions provided by the 
installer. The installation dialog displays an 
important ReadMe. 

4 Click Accept after reading the complete 
ReadMe. 

Canoma Installation Tip

• Macintosh tip: Increase available RAM 
available to Canoma by allocating unused 
RAM to Canoma. This can allow Canoma 
to run faster and handle larger files or 
larger renderings. 

Be sure to leave some RAM for the system 
software, though! System software needs to 
be able to dynamically allocate RAM to 
itself when required. 
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Introduction 
Canoma lets you quickly create 3D models from 
scanned or digital photographs. Canoma 
models can then be posted on Web sites, used 
in electronic catalogs, imported into traditional 
3D modeling and animation software, or 
rendered as 2D image files. 

The Canoma Workspace 
This section leads you through the Canoma 
Workspace. 

The first thing you’ll notice about Canoma is 
that it doesn’t have traditional floating palettes 
and toolbars. All of Canoma’s features are 
integrated into the Workspace, which takes over 
your entire screen. This helps keep everything 
uncluttered and easy to locate. 

Your operating system’s standard menus and 
windows are still available from within 
Canoma. You can switch between Canoma and 
other applications, such as 2D paint programs, 
Web browsers, or 3D programs. 

On Windows, Canoma always runs maximized. 
You can’t reduce the window size, although you 
can minimize the Canoma window, using the 
minimize control or switch applications, using 
ALT-TAB or the application buttons in the Task 
Bar. On the Macintosh, you can switch 
applications by clicking inside the window for 
the other application or by using the 
Application List. 

The Canoma Workspace is very flexible. Several 
controls “float” over the Workspace and can be 
moved by dragging them to other locations on 
the application workspace. 

The Canoma Project Window 

The Canoma Project Window is a square 
shaped window inside the Canoma application 
window. It’s where you construct and view a 
Canoma model. 

The Project Window is used when you edit 
your models, manipulating object wireframes in 
Edit mode. It’s your work area where you’ll pin 
3D objects to picture elements. The Project 
Window can be resized to suit your needs (grab 

The Canoma Workspace takes over your screen and 
provides access to the Canoma controls. 
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it by the lower left corner) and moved to 
another part of the Canoma workspace (by the 
title bar.) 

The Project Window is also where you view the 
3D models you create. The view you see of your 
model in the Project Window is taken through 
a stationary “camera.” You can reposition the 
Canoma camera in order to view your model 
from different angles or distances. When you 
view a 3D model, you’re in a three dimensional 
space. That means you can even view your 
model from below or above.

Just outside the Project Window are some 
information displays and buttons. Along the 
top of the window is the title of your project 
and its size. To the top right of the window are 
three buttons that toggle display options on 
and off. To the bottom right of the window are 
buttons that let you change the color for 
program elements such as the background, 
selected objects, unselected objects, objects in 
the stress display, shadows, and object 
constraints. 

Camera Controls 

Use the Camera Controls to change the 
position and function of the viewing camera. 

The Edit and View buttons switch between: 

• Edit mode, where you can see the 
wireframe objects that make up your 
model and

The Canoma Project Window is where you construct 3D 
model. 

The Canoma Project Window is where you view your 3D 
models. 

Tip If you’re familiar with Bryce 3D 
or Poser by MetaCreations, the 
Camera Controls feel very 
familiar. 
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• View mode, where you can see the 
untextured or textured 3D model. 

The Camera Crosses let you move the view of 
the camera specifically along X, Y, and Z axis. 
The Camera Trackball lets you rotate the 
camera in any direction and around any axis. 
The Banking and Field of View control spheres 
tilt your Camera and act like a wide-angle lens 
control. Refer to “Positioning the View of Your 
Model” on page 102 for more about positioning 
the camera around your model. 

The Creation Tab

The Creation Tab contains the 3D objects, like 
boxes, rectangles, and even editable polyline 
contours. Select one of these 3D objects, 
position it, then “pin” it to an element in your 
photograph. Once pinned into place, Canoma 

uses that placement information to create a 3D 
model, which can then be “covered” with the 
pixels from your photographs. 

Refer to “Working with Objects” on page 77 for 
more about the Creation Tab. 

The Toolbar 

The Canoma Toolbar holds the tools you’ll use 
to manipulate objects, view your work, and 
apply or edit textures. Click a button to activate 
that tool.

The Toolbar contains (from left to right):

• Arrow (select, pin, or apply beads)

• Glue (glue objects together) 

• Zoom and Pan (move into, away from, or 
around your scene) 

• Point Pen (add/delete polyline contour 
points) 

• Texture Brush (change textures at a pixel 
level) 

• Quick and Quality Textures (apply 
photograph pixels as textures for your 3D 
scene) 

Use the Camera Controls to adjust the position of the 3D 
viewing camera. 

Use the scrollbar on the Creation Tab to view all the 
objects you can choose. 
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When a tool is selected, it is highlighted in the 
Toolbar. At the top of the Toolbar is a title that 
identifies which tool is active. 

Selecting Objects

You can use the Object List to easily select an 
object in your scene. The Information button 
brings up a dialog of object settings for the 
selected object. You can even switch into Solo 
Mode, where it’s easier to see just the object 
that you’re working with. 

2D Image Palette

A thumbnail of your photograph is displayed 
on the 2D Image Palette. This is a thumbnail of 
the active image. The 2D Image Palette opens 
downward to reveal all the photographs in your 

project. Refer to “Using 2D Source Images” on 
page 74 for more about using the 2D Image 
Views window. 

Texture Controls

The Texture Controls apply the pixels of your 
photograph to your 3D model. You can use 
Quick Texture (fast) or Quality Texture (slower, 
uses more memory, but looks better.) You can 
also use the Texture Resolution popup to 
choose a resolution setting for the textures you 
apply. 

Refer to “Working with Texture” on page 97 for 
more information about adding Texture. 

The Canoma Toolbar. 

Click the Information button for object settings, then use 
Solo Mode to focus on one object at a time. 

The 2D Image palette. 

Choose Quick or Quality Texture, as well as a resolution 
setting. 
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The Animation Tab 

The Animation Tab holds the controls you need 
to use in order to quickly define key frames and 
set options to create an animation. Move the 
camera, take a “snapshot,” move the camera, 
take another snapshot, then Canoma completes 
the work by interpolating between the 
keyframes you’ve snapped or “filling in the 
gaps.” 

The Animation Tab contains controls for 
adding and deleting keyframes, a looping 
option, a way to set the playback duration, and 
buttons for previewing your animation. Refer to 
“Previewing an Animation” on page 117 for 
more about the animation controls. 

The Menu Bar 

The Canoma Menu Bar contains eight menus: 
the File menu, the Edit menu, the View menu, 
the Model menu, the Texture menu, the 
Animation menu, the Window menu, and the 
Help menu. These menus provide another 
method of access to the Canoma feature set. 

Status Tips 
As you move the cursor over an element of the 
Canoma workspace, text in the lower right 
corner of the screen explains the purpose of 

each. Use Status Tips to “browse” around the 
work area and become familiar with Canoma 
tools, palettes, and dialogs. 

About Canoma 
You can view information about which version 
of Canoma you are using. 

To see Canoma information: 

• Click the word Canoma. 

Accessing the 
MetaCreations Web Site 
You can access the MetaCreations Web Site 
directly from within the Canoma program. 

To access the MetaCreations Web Site: 

• Click the word MetaCreations. This 
launches your browser and opens the 
MetaCreations Web Site. 

The Animation Controls. 

Status Tips help you become familiar with Canoma tools, 
palettes, and dialogs. 

Check here for Status Tips
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